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ABSTRACT

In this Thesis paper we propose the antenna geometry to design a very compact
microstrip patch antenna for ultra-wide band application using thin dielectric
substrate having low dielectric constant. This antenna provides better efficiency,
better band-width without any enhancement in the weight, volume or cost.
HFSS high frequency simulator is employed to analyze the proposed antenna
and simulated results on return loss, gain, radiation pattern is presented. The
antenna parameter in frequency domain analysis has been investigated to show
its capability as an effective radiating element. Our new shape of antenna which
is D over D shape can operate at 4.78-8.48 GHZ frequency range. Due to low-
profile structure it can be used in the WLAN (wireless local area network),
Router, WI-FI, Modem and other wireless application using this frequency
range.
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Chapter one
Introduction To Microstrip (Patch) Antenna

1.1 Introduction

This chapter basically introduces the normal concepts of patch antennas.
We use a simple rectangular, half wave long, probe-fed patch operating in its
fundamental mode as an example.

Topics include principles of operation, impedance matching, radiation
patterns, circular polarization, bandwidth, efficiency, alternative feed types,
stacked patches and higher mode behavior.

1.2 Patch Antenna:

Modern wireless communication systems and increasing of other wireless
applications require low cost and high performance multiband antennas. The
demand for high performance multi standard communication system has led the
antenna research and studies in various directions. One of them the design of the
multiband microstrip(patch) antennas.

Microstrip or patch antennas are becoming increasingly useful because
they can be printed directly onto a circuit board. Microstrip (patch) antennas are
becoming very widespread within the mobile phone market. Patch antennas
have become quite popular due to their low cost; have a low profile design and
ease of manufacturing.

1|Page



Microstrip Feed

Patch

substrate

Ground Flane

Fig 1.1: view of Patch Antenna

1.3 History of Microstrip Antenna

The microstrip antenna was first proposed by G.A. Deschamps in 1953,
but didn't become practical until the 1970s when it was developed further by
researchers such as Robert E. Munson and others using low-loss soft substrate
materials that were just becoming available.

1.4 Motivation for this study

The size of a microstrip antenna is inversely proportional to its frequency.
At frequencies lower than microwave, microstrip patches don't make sense
because of the sizes required. At X-band a microstrip antenna is on the order of
1 centimeter long (easy to realize on soft-board technology). If you wanted to
make a microstrip antenna to receive FM radio at 100 MHz it would be on the
order of 1 meter long (which is a very large circuit for any type of substrate) For
AM radio at 1000 KHz, the microstrip patch would be the size of a football
field, basically impractical. One everyday application where microstrip patches
are used is in satellite radio receivers. Here the antenna is often mounted in a
vehicle, where the angle in the X-Y plane relative to the satellite is not fixed
(like it is for the satellite television dish mounted to your house.) Thus circular
polarization is employed for satellite radio, and the angle that the patch is with
respect to the satellite doesn't matter.
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Chapter 2

Basic Architecture of Patch Antenna

2.1 Antenna Architecture

The following drawing show a patch antenna in its basic form: a flat plate
over ground plane shown in figure 2.1

Patch

Diclectric Substrate

Crround Plane

Fig 2.1: structure of microstrip antenna.

Consider the microstrip antenna shown in figure 2.1,the patch and the
ground plane are made of high conductivity metal( typically copper).The patch
is of length L, width W and on the top if a substrate( some dielectric circuit
board) of thickness h with permittivity. The thickness of the ground plane or of
the microstrip is not critically important. Typically the height h is much smaller
than the wavelength of operation but should not be much smaller than 0.025 of
a wavelength for an efficient antenna. And the feed line is used to feed the
patch.
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2 .2 Antenna Geometry

The radiating micro strip antenna can be Dipole or can be square,
circular, elliptical, dipole, triangle or rectangular etc. Rectangular and circular
microstrip patch antennas are most widely used antenna in wireless
communication.

/50 ,w
/4—)/'(%/'
/ oA B patch 4
P e A / &
Circular Dipole 5o Vaw = V' 4
Square T V4

I hl dielectric (¢) |~ y

O Ground

Elliptical Rectangular

Rectangular Microstrip

Different Shapes of Antenna
Micro strip Antenna
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2.3 Dimensions

The resonant length determines the resonance frequency and is about Ay4/2
for a rectangular patch excited in its fundamental mode where A4 iS the
wavelength in the PCB material. The patch is actually a bit larger electrically
than its physical dimensions due to the fringing fields and the difference
between electrical and physical size is mainly dependent on the PC board
thickness and dielectric constant of the substrate.

A good approximation for the resonant length is:
L~0.49
g = 0.49 MOINE,

This formula includes a first order correction for the edge extension due
to the fringing fields with:

e L =resonant length

e )4 =wavelength in PC board

e ) =wavelength in free space

e ¢ =dielectric constant of the printed circuit board material

Other parameters that have less influence on the resonant frequency include:

e Ground plane size
o Metal (copper) and dielectric thickness
e Patch (impedance) width.
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2.4 Advantages and Disadvantages

Advantages of micro strip antennas include:

>
>

YV V V

Y V

Low cost to fabricate

Conformal structures are possible( it’s easy to form curved surfaces
as long as the curve is in one direction only)

Light weight

Supports linear and circular polarization

Low volume

The unique property of micro strip antenna is its two dimensional
structure

Easy to manufacture

The effective wavelengths are much smaller.

Disadvantages include:

>

>
>
>
>

Limited bandwidth(usually 1to 5% but much more is possible with
increased complexity

Low power handling

Low frequency

Small polarization

Poor gain
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Chapter 3
Analysis of feeding methods

Different feeding techniques of micro strip patch antennas with different
spiral defected ground structures are presented in this chapter. In the analysis of
the impact of feeding on the parameters of the antennas will be considered work
bandwidth antennas, impedance matching and shape of the radiation pattern.
We try sought a solution that will give the wideband of work while maintaining
a directional radiation patterns. The most popular types are micro strip line feed,
coaxial feed, aperture coupled, proximity coupled, probe feed patch and so on.
A number of feed mechanisms have been developed for micro-strip antennas.
Most often it is the feed mechanism that determines the complexity of the
antenna design. Popular feed techniques can be classified into four broad
categories are as follows.

3.1 Micro strip feed line

This method of feeding is very widely used because it is very simple to
design and analyze and very easy to manufacture. Figure-3.1 shows a patch with
microstrip line feed from the side of the patch. It is widely used in both one
patch antenna and multi-patches (array) antennas. Micro strip feed line is a
conducting strip and it is directly connected to the edge of the micro strip patch.
The advantage of this structure is the ability to place circuitry near the elements
on the same substrate and avoid a multi-layer board. Also elements can be
connected in parallel in the same plane to form an array. With this type of feed,
impedance transformation to a useful value is needed as the impedance near the
edge of the patch is quite high (a couple hundred Q typical).

Microstrip Feed

Greound Plane

Fig 3.1: micro strip line feed
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3.2 Aperture coupled feed

An aperture-coupled design is proposed for Micro strip slot antenna to
Improve its radiation pattern as well as bandwidth. It is based on coupling of an
aperture between the patch antenna and Micro strip slot line. The first aperture
coupled micro strip antenna was introduced in 1985 by D M Pozer. The
geometry of an aperture coupled micro strip antenna is shown in Fig. 3.2. It
consists of two substrates bonded together, with a ground plane in between. The
radiating patch is printed on the top (antenna) substrate; while a microstrip feed
line is printed on the bottom (feed) substrate. A small non resonant aperture in
the ground plane. The impedance bandwidth of a basic patch is a couple % at
best. The radiation bandwidth is usually much larger and can be up to 50%.
Aperture coupling to a patch is a classic impedance bandwidth enhancement
technique. The microstrip fed aperture coupled patch may suffer from a reduced
front to back ratio. A strip line feed avoids this: the feed line is ‘captured’
between two ground layers.

Fig 3.2: Aperture coupled feed.
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3.3 Coaxial Feed Line

A classic way to feed a patch antenna is by using a coaxial probe or
connector mounted at the appropriate impedance point and we will look at a
couple of alternate ways to connect to a patch. Since in most patch antennas, the
impedance bandwidth is much smaller than the radiation bandwidth, we will
also look at some techniques to increase the bandwidth.

While the probe feed discussed so far has a bandwidth of only a couple
%, it is still very useful for a lot of applications like GPS and WLAN. The
coaxial feed cable has two conductor-inner conductor and outer conductor. In
figure the coaxial feed line is connected to the radiating patch and the outer
conductor is connected to the ground.

Coaial cable

Fig 3.3: Probe feed rectangular micro strip antenna

9|Page



Chapter 4

Antenna Design

Antenna parameters are used to characterize performance of an antenna
when designing and measuring antenna. This chapter we discuss bandwidth,
polarization, radiation pattern, gain, input impedance that is related to antenna
design.

4.1 Bandwidth

The most important parameter of an antenna is the bandwidth it covers.
Most of the time only impedance or return loss bandwidth is specified.
However, it is important to realize that several other definitions of bandwidth
exist: directivity bandwidth, polarization bandwidth and efficiency bandwidth.
Directivity and efficiency are often combined to gain bandwidth.

Equation of Bandwidth is f,-f/fy and % BW=f,-f,/f, * 100%, where fo=f,+f,/2

4.2 Radiation pattern

The radiation pattern of an antenna is the power radiated or received by
an antenna. The patch's radiation at the fringing fields results in a certain far
field radiation pattern. This radiation pattern shows that the antenna radiates mo
re power in a certain direction than another direction. The antenna is said to hav
e certain directivity. This is commonly expressed in dB; if the antenna had
100% radiation efficiency then all directivity would be converted to gain.
Typical half wave patches have efficiencies well above 90%.

Radiation pattern of an antenna can be defined as the locus of all points
where the emitted power per unit surface is the same.

A plot through which it is visualizes where the antenna transmits or
receives power. The microstrip antenna radiates normal to its patch surface. So,
the elevation pattern for ¢= 0 and ¢= 90 degrees are important for the
measurement.

The rectangular patch excited in its fundamental mode has a maximum di
rectivity in the direction perpendicular to the patch
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(a) Patch Antenna Model
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(c) Patch Antenna Azimuth Plane Pattern (d) Patch Antenna Elevation Plane Pattern

Fig4.1: Radiation pattern of patch antenna

Assuming all radiation occurs in one half of the hemisphere, this resultsina3d
B directivity. This case is often described as a perfect front-to-back ratio; all rad
lation towards the front and no radiation towards the back. This front-to-back ra
tio is highly dependent on ground-plane size and shape in practical cases. Anoth
er 3 dB can be added since there are 2 slots. The slots are typically taken to have
a length equalto the impedance width (length according to the y-axis) of the pat
ch and a width equal to the substrate height. Such a slot typically has a gain of a
bout 2 to 3 dB (simple dipole). This results in a total gain of 8 to 9 dB.
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4.3 Antenna Gain

Antennas do not have gain because they are passive structures. Antenna
gain is defined as antenna directivity times a factor representing the radiation

efficiency. Antenna gain defined as the efficiency of the ratio of the
radiated power and to the input power. Due to isotropic as ideal antenna we take
dB as reference unit.

Antenna gain can also be specified using the total efficiency instead of th
e radiation efficiency only. This total efficiency is a combination of the radiatio
n efficiency and efficiency linked to the impedance matching of the antenna.
Radiation efficiency is always lower than 100% so the antenna gain is always
lower than antenna directivity.

Antenna gain can also be specified using the total efficiency rather than
just the radiation efficiency. This total efficiency is a combination of the
radiation efficiency and efficiency linked to the impedance matching of the
antenna.

It is defined as the ratio of the intensity (power per unit surface) radiated
by the antenna in a given direction at an arbitrary distance divided by the
intensity radiated at the same distance by an hypothetical isotropic antenna.
Gain is a key performance figure which combines the antenna’s directivity and
electrical efficiency.

Gain [dB]

Fig 4.2: Gainin dB
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4.4 Directivity

The ratio of the radiation intensity in a pre-arranged direction
from the antenna to the radiation intensity averaged over all
directions.

This is the frequency range wherein the antenna meets a certain
directivity/gain requirement (1 dB gain  flatness). The average

radiation power intensity is equivalent to the radiated power by the
antenna divided by 4.

Directivity (dB)

25 1 15 4 45 5 55

Frequency (GHz)

Fig 4.3: Directivity in dB
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4.5 Return loss

This can be defined as difference in dB between the forward and reflected
power measured at a given point in an RF system. Return Loss is a measure of
how much power is delivered from the source to a load and measured by 11
parameters. Bandwidth is the range of frequencies over which the antenna can
operate effectively. Bandwidth can be calculated by going 10 dB down in return
loss. Equation of Return Loss is -20logS;; here S;; is Return loss value.

-10

-

-
PRV T T

I air gap=42mm
= —air gap=43mm
-==air gap=44mm
—-rair gap=45mm
rrrrrr air gap=46mm

o
th

Return loss(dB)
o
=

-30 .
— - -air gap=47mm
35 ---air gap=48mm
-40
0.5 0.6 0.7 0.8 0.9 1 1.1 1.2

Frequency(GHz)

Fig 4.4: Return loss
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4.6 Polarization

In last few years, researchers have looked into the designing of circular
polarized antennas. Circular- polarization enables to receive or transmit through
antennas without significantly changing the output voltage. In many
applications, these antennas operating at low power density, when the
transmitting power is low and the transmission distance is long.The advantage
of this antenna over a linearly polarized antenna is that it has nearly constant dc
output and it can achieve the retina’s rotation angle, relative to the transmitter
changes.

The plane wherein the electric field varies is also known as the polarizatio
n plane. The basic patch covered until now is linearly polarized since the electri
c field only varies in one direction.A large number of applications, including sat
ellite communication, have trouble with linear polarization because the orientati
on of the antennasis variable or unknown. Luckily, there is another kind of polar
ization -- circular polarization. In a circular polarized antenna, the electric field
varies in two orthogonal planes (x and y direction) with the same magnitude and
a 90degree phase direction.

4.7 Voltage Standing Wave Ratio (VSWR)

The VSWR is defined Voltage Standing Wave Ratio. VSWRis a
measure of the reflected power on a transmission line. It is an important
specification for all communication devices. It measures how well an antenna is
matched to the cable impedance.
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4.8 Applications of the Micro Strip Antenna

> Satellite Communication:

= Satellite communication requires circularly polarized
radiation patterns, which can be realized using either square
or circular patch micro strip antenna.

> Global Positioning Satellite (GPS) system:

= In circularly polarized micro strip antenna are used. They are
very compact in size and quite expensive due to their
positioning.

» RFID:

= Micro strip antennas are also used in the fields of RFID
(radio frequency identification), mobile communication and
healthcare. Basically, an RFID system consists of a tag and a
reader. Generally, it uses frequencies between 30 Hz and 5.8

GHz.

> Medical applications:

= In the treatment of malignant tumors, microwave energy is
said to be the most effective way of inducing hyperthermia.
The radiator to be used  for this purpose should be light-
weight, easy to handle and rugged. Only a patch radiator
fulfills these requirements.

> Medical Application with textile:

= There are some applications at present where antennae are
used to continuously monitor biometric data of the human
body. In order to do this, they need to be so close to the
human body all the time that they can continuously monitor
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the biometric data and send the information to the outside
world. If the antenna is hard, it cannot be kept always
attached with the human body. An antenna made of textile
material will not harm the human body and can be worn for
extended periods. Wearable antennae will find use in
healthcare, recreation, fire-fighting, etc.

= Textile materials are increasingly being used for
development of flexible wearable systems due to the
recent miniaturization of wireless devices. For flexible
antennae, textile materials form interesting substrates,
because fabric antennae can be easily integrated into
clothes.
In this special type of patch antenna, the radiating patch
and the ground plane are made up of conductive textile
material. The substrate too is a textile material with
specific dielectric constant. As everything is made up of
textile material, it is called textile antenna.

> Mobile communication:

= Mobile communication requires small, low-cost, low-profile
antennae. In some mobile handsets, semiconductor-based
diodes or detectors are used as antennae. They are much like
p-n diode photo-detectors but work at microwave frequency.
Many times Omni directional antenna is used in mobile
phones. There are different kinds of antennae like planar
inverted-F antenna, folded inverted conformal antenna and
mono pole. Also retractable whip antenna is commonly used
in handsets.

The phone is subdivided into roughly 60 components, each

consisting of hundreds or even thousands of individual
facets.
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» Some communication-based applications of micro strip patch antennae
are radio altimeters, command and control systems, remote sensing and
environmental instrumentation, feed elements in complex antennae,
satellite navigation receivers, mobile radio, integrated antennae,
biomedical radiators and intruder alarms, Doppler and other radars, and
satellite communication and direct broadcast services.

4.9 Ultra Wide Band (UWB)

Ultra wideband (also known as UWB or as digital pulse wireless) is
a wireless technology for transmitting large amounts of digital data over a wide
spectrum of frequency bands with very low power for a short distance. Ultra-
wideband is a technology for transmitting information spread over a large
bandwidth >500 MHz ultra-wideband transmissions can legally operate in the
range 3.1 GHz up to 10.6 GHz, at a limited transmit power of -41dBm/MHz
Additionally the transmissions must occupy a bandwidth of at least 500 MHz,
as well as having a bandwidth of at least 20% of the center frequency. To
achieve this last requirement, a transmission with a center frequency of 6 GHz,
for example, must have a bandwidth of at least 1.2 GHz. Consequently, UWB
provides dramatic channel capacity at short range that limits interference.

4.9.1 Ultra Wideband Application:

Ultra Wide Band has two types application:

v" Applications involving radar, in which the signal penetrates nearby
surfaces but reflects surfaces that are farther away, allowing
objects to be detected behind walls or other coverings.

v" Voice and data transmission using digital pulses, allowing a very

low powered and relatively low cost signal to carry information at
very high rates within a restricted range.
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Chapter 5
Overview OF HFSS

Ansoft HFSS (High Frequency Structural Simulator) is an interactive
software package for calculating the electromagnetic (EM) behavior of a 3D
structure. The software also includes post-processing commands for analyzing
the electromagnetic behavior of a 3D structure in more detail. Ansoft HFSS
software contains the technology, solvers and capabilities needed to model RF
and microwave as well as signal- and power-integrity issues.

Using Ansoft HFSS, you can compute:

¢ |t integrates simulation, visualization; solid modeling and automation in a
stress free situation which gives solutions to your 3D EM difficulties are
fast and exactly found.

e Basic electromagnetic field quantities and, for open boundary problems,
radiated near and far fields.

o Generalized S-parameters and S-parameters renormalized to specific port
impedances.

e Characteristic port impedances and propagation constants.

You are expected to draw the structure, specify material characteristics
for each object and identify ports and special surface characteristics. The system
then generates the necessary field solutions, resonant frequency and associated
port characteristics and S-parameters. It employs the Finite Element Method
(FEM), adaptive meshing and brilliant graphics that give you unparalleled
performance and insight to all your 3D EM problems
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5.1 HFSS Capabilities:

HFSS stands for “High frequency structure simulator”, it is a Finite

element code capable of solving a variety of EM problems:

>

>

IC packages, PCB interconnects, and high-frequency components such as
Antennas, RF/microwave components.

Material properties such as ferrites as well as surface properties can be
readily modeled.

Tangential vector basis functions enabled the highly accurate finite
element method for electromagnetic field solution.

Transfinite element method for fast and accurate multimode.

S-parameter extractions.

Automatic mesh generation and adaptive refinement for reliable,
repeatable and efficient results.

Typically HFSS is used for the simulation of Antenna's and circuit
boards. However it can and is used by several laboratories around the
world for cavity design (CERN, FNAL, DESY to name a few).

HFSS is a cooperative simulation system whose mesh element is a

tetrahedron. It will permit you to solve any arbitrary 3D geometry, mainly for
those with complex curves and shapes, in a fraction of the time it would take
using other techniques. Ansoft founded the use of the FEM (finite element
method) for EM (electromagnetic) simulator by implementing technologies
such as tangential vector finite elements, adaptive meshing, and adaptive
lanczos-pade sweep (ALPS). Ongoing process of HFSS to lead the industry
with improvements such as Modesto-nodes and full wave spice.

Ansoft HFSS have changed over a period of choice for high-productivity

research, development and virtual prototyping.
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5.2 Helping Procedure

If you are facing any problem or having any questions while using Ansoft
HFSS then you can have the solution in such ways:

5.2.1 Online Help

It will provide guidelines while you are working:

To get the help of specific active dialog box, click the help option
in the dialog box or press F1 key.

Select the menu item help > contents to have the online help
system.

Options are available there to provide information about every
tool on the toolbars or dialog boxes. You have to hold the pointer
over a tool for a brief time; a tool trip will display the name of the
tool.

If you click a menu item the status bar at the bottom of the Ansoft
HFSS window will provide a brief description of the function of
the menu item or tool.

Ansoft HFSS getting started guide provides detailed information
and solution of problems that faced through using it to create and
solve 3D EM projects.

5.2.2 Technical support

To contact the Ansoft technical support staff in your geographical
area you have to log on to the Ansoft corporate website,
ansoft.com and select content.

Your Ansoft sales engineer may also be connected in order to
provide this information.
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5.2.3 Ansoft Web Site Visit

If you are connected through the internet then you can easily visit Ansoft
web site to learn more about the Ansoft Company and products.

e From the Ansoft desktop select the menu item > Ansoft corporate
website to access the Online Technical Support (OTS) system.
e Now from your internet browser visit ansoft.com

5.2.4 Procedural Support

The following link will direct you to the Ansoft support page. It will
provide additional documentation, training and application notes.

5.3 HFSS Main Portions

Ansoft HFSS window has several optional panels:
I. Project Manager
1i. Message Manager
iii. Property Window
iv. Progress Window
v. 3D Modeler Window

Above Managers and windows are shown in fig 5.1 and their details are
given in approaching sections
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Fig.5.1: Ansoft HFSS window

5.3.1 Project Manager

The project you have done in Ansoft HFSS, the project manager will
show you the creations of your own project structure design tree are shown
below in Fig.5.2

Project Manager

El" Project7
é..@ HFS5Design1 (Driven Terminal)

& Mogl

..ﬁ’ Boundaries

..ﬂ Excitations

@ Mesh Operations

}? Analysis

[ Optimetrics

Part Field Display
T Field Overlays
';' Radiation
(-] Definitions

Project

Fig 5.2: Ansoft HFSS project Manager
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5.3.2 Massage Manager

After creating the project the massage manager will give you the
information about you project like you have an error or any warnings it will
mention on the massage manager that occur before simulation and after
simulation it will deliver the project report on screen of it that is shown by Fig
5.3

E

mRiaa] Project/ (C:/\sers/ Shanchita/Documents/ Ansaft/)
- g HFSSDesign] (DivenTeming]
ﬂ Nomal completion of smulation on server: Local Machine. (5:35:21 AM Dec 03, 2015)

-

FMessaqge Mamnager

Fig 5.3: Ansoft HFSS Massage Manager
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5.3.3 Properties window

Properties window will show u the command or the value you put on
your design will provide on this window is given below by the Fig.5.4

PropertiessFinal Project - HFSSDesignl - Medeler b
Command
Name Value | Unit | Evaluated Value Description

Command CreateRectangle

Coordinate Sys... Global

Position 0957216 mm D5mm , 3.72m...

Pz z

*Size 18 mm 1.8mm

fSize 20 mm 20mm

[ Show Hidden i
oK Cancel

Fig 5.4: Ansoft HFSS Progress Window.
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5.3.4 Progress Window

Progress window shows the solution progress is shown below in Fig 5.5

] File Edit View

fpooP b f

Project Draw Modeler HFSS Tools Window Help

iIBEZ4B|0or|BiB B BFi~d 2t

SR

=

FE R
fed @ [% ® s 9 ok @
Project Manager - x & Solids
- Project7* 149 air
£) g HFSSDesign 1 (DrivenTerminal)™ B &7 radiation_b
1.&P Model  CreateB
-EP Boundaries 4 pec
9 Exctations 4% Rogers RO3210 (tm)
i@ Mesh Operstions G149 vacuum
4P Analysis [ Sheets
P Sepl 3 Perfect E
I Optimetrics B Wave Port
B[ Resuts 3 Unassigned
L BB XY Pt le. Coordinate Systems
= 4B Planes
@ Lists ;
0 50 100 (mm)
’: Project? - HFSSDesign’ - Setupl: Sohing ddaptive Pass #14 on Local Machine - RUNNING ’: 2 Project7 (C:/Users/Shanchita/Documerts/Ansoft/)
Buiding matrix
Neme [Valus | Uit | Evalusted Vaiue
d...
Materal "air”
£ _Aibute
NUM

1 objects are selected

5.3.5 3D Modeler Window

Fig.5.5: Ansoft HFSS Progress Window.

3D Modeler Window in this is area where you cancreate the model
geometry. This window consists of the model view area (or grid) and the history
tree as shown in Figure 5.6, 5.7, 5.8. The history tree documents the actions
that have been taken in the model view area, and provides an alternative way to

select objects in the model view area.

A 3D Modeler window contains the model and the model tree for the
active design is give below in Fig.5.6 and 5.7, 5.8:
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Fig.5.6: Ansoft HFSS 3D Modeler Window with Model.
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Coordinate system Ori

Fig: 5.7: Coordinate System (CS).
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Project Manager
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Fig.5.8: 3D Modeler design tree

5.4 Toolbars

The toolbar buttons are shortcuts for frequently used commands. Most of
the available toolbar are displayed in this illustration of the Ansoft HFSS initial
screen, but your Ansoft HFSS window probably will not be arranged this way.

You can customize your toolbar display in a way that is convenient for
you. Some toolbars are always displayed; other toolbars display automatically
when you select a document of the related type. For example, when you select a
2D report from the project tree, the 2D report toolbar displays, as shown in Fig
5.9:

ol Angot H§ - Projectl=[EDe

L Fle bt View Proet Draw Mol HESSE Took Window Hel

D@ eRgxocEiy]  Imuingke
R inonodiogRa0esonic vafr J 1
Bl by

133080808 883 95101+
. : i ! Ragers RT/dur v ’m =

Fig 5.9: Ansoft HFSS Toolbars.
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5.4.1 To display or hide individual toolbars

¢ Right-click the Ansoft HFSS window frame,
= A list of all the toolbars is displayed. The toolbars with a

check mark beside them are visible; the toolbars without a
check mark are hidden. Click the toolbar name to turn its
display mood on or off.
e To make changes to the toolbars, select the menu item Tools >
Customize.

=] Properties panels

] Project Manager
Bl Message Manager Ansoft HFSS
¥ Prooress

30 Miodeler View INtEracion
2 Maodler Drame

30 Madeler Bookean

30 Madser LTange

0 Madder Dupfcabe

30 Miaddler Material

A0 Madder Selection Mods

0 Madder Srap Mada

3o Miadeler Grid

I Modder Coordinake System

Toolbars <

EEEEEEEEEERE

Customize..,
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5.5 Ansoft HFSS Process:

The Ansoft HFSS Desktop Provides an easy way of interfacing to
develop passive RF device models. Creating designs, involves following:

Parametric Model generation: producing the geometry, boundaries and
excitations.

Analysis setup: Creating solution Setup and frequency sweeps.
Results: Creating 2D reports and field plots.

Solve Loop: The solution process is fully automated by analyzing it.

How this Process exists is given below:

Design

¥

Solution Type

¥

ParametricModel
(Geometry/Materials)

i Mesh
+ Boundaries Oporati
¢+ Excitations erations

‘ Mesh Solve
Refinem ent
Analysis ]

+ Solution setup
¢ Frequency sweep

\ 4

Results

2D Reports, Fields)

Fig.5.10: Ansoft HFSS Procedure Flow Chart.

Analyze

.

¥

Update

Conv erged

{—

Finished
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5.6 Functioning a HFSS Project

This part will describe how to create a new or existing project.

5.6.1: Functioning a New Project

To create a new project procedure is given below:

e In a Ansoft HFSS window , first you have to select the menu File
>New

e Then you have to press the Project > Insert HFSS design.

e Now by giving a file name, you have to press File > save button to

create a project.

5.6.2 Functioning an existing HFSS Project

To open up an existing project:

First you have to open up the menu File > Open, use the open button to
select the project,

Now select the project name to open the desire file you want to work

@ Open * &
Look in: Ansoft j £ Edv
= Name = + | Date modified Type *
a : ;
Project?.hfssresults 12/9/2015 9:58 PM File fol
Recent Places X
san_2.hfssresults 12/9/2015 5:35 PM File fol
! @ B shape 11/3/201511:01 AM  Anseft
Desktop @ dipole 8/22/201510:58 PM  Ansoft
— @jk_E_d 9/7/20159:32 PM Ansoft
i=all @ new shape 10/12/20157:36 PM  Ansoft select file to preview
Libraries @ pinky 11/26/201512:33 .. Ansoft
¥ L @ Project3 8/14/2015 3:20 PM Ansoft
e @ Projectd 10/8/20158:32 AM  Ansoft| -
C°T”D”‘9r D Projects 12/9/2015 6:03 AM  Ansoft
{g @ Project? 12/9/2015 5:52 PM Ansoft
Network @ san_2 12/9/2015 5:35 PM Ansoft =
4 mn 3
File name | ﬂ Open
Files of type: |Ansoﬂ HFSS Project Files [~ hfss) j Cancel

Fig 5.11: Opening a HFSS Project
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5.7 Basic Type

Solution type is containing how the excitations and convergences are
defined. The following solution types are available In Ansoft HFSS:

Driven Modal: Calculates the modal-based S-parameters. The S-matrix
solutions will be expressed in terms of the incident and reflected powers of
waveguide modes. Driven Modal is used for problems where the transmission
line supports a non-TEM mode such as microstrip, waveguides, CPW, etc.
Driven Terminal is used when your problem involves multiple and closely
coupled transmission lines each supporting quasi-TEM modes such as a signal
integrity problem. You can also use Driven Terminal when your structure
supports a TEM mode like feed line, coax. If you are simulating just a
microwave component (i.e., antenna, waveguide, filter, coupler, etc...) use the
Driven Model Solution type.

Driven Terminal: calculates the terminal-based S-parameters of multi
conductor transmission line ports. The S-matrix solutions will be expressed in
terms of terminal voltages and currents.

Driven transient: It employs a time domain solver. Distinctive
applications are included but don’t have any limitations with pulsed excitations,
thus Ultra wide band antennas, lighting strikes, electro static discharge, field
visualization, employing short-duration excitations; time domain reflection.

Eignemode: calculate the Eigen modes, or resonances, of a structure. The
Eigen mode solver finds the resonant frequencies of the structure and the fields
at those resonant frequencies.

5.8 Conjunction

I. Driven Modal — Delta S for modal S-Parameters. This was the only
convergence method available for Driven Solutions in previous
Versions.

Ii. Driven Terminal New — Delta S for the single-ended or differential
nodalS-Parameters.

Ii. Eigenmode - Delta F
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5.9 Solution Type
Select menu item HFSS>solution type to choose one of the following terminal

e Driven Modal

e Driven Terminal
e Driven Transient
e Eigen Mode

Click the ok button to have the desire terminal is shown below by Fig 5.12

Solution Type: Project? - HFSSDesignl (B

(" Driven Maodal
! {+ Driven T eminal
" Eigenmode

" Transient

r

! (] | Cahcel |

Fig 5.12: Solution Type.

Parametric and Optimization Using Ansoft HFSS

Optometric is a powerful new feature in Ansoft HFSS that provides
parametric and optimization capabilities for 3-D RF and microwave design
problems. The approach used is very general and allows any design quantity to
be parameterized and optimized. It even allows outside programs such as
MatLab to be used to drive the optimization. Significant applications of
Optometric include fine-tuning preliminary designs, searching the design space
for acceptable designs and the possibility of creating excellent designs from
scratch. All of these applications provide good productivity improvements for
designers and allow precision designs to be created with minimal cost and time.
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HFSS Design Setup

In Ansoft HFSS introduction you know about how to create project and
all the solution type. Creating a project and when you have to start work in it,
you have to draw the dielectric part, substrate, feedline and in design procedure
you have to select boundary, Excitations , validation check, Analysis, Analyze
and finally you get Result after simulation.

5.10 Boolean Function:

In Ansoft HFSS when you create project to design an antenna, first you
have to select substrate material then creating a patch you have to and port you
want for your design. Now to create your desire design you need the Boolean
function to subtract then unite that to Boolean function is mostly used to create
a desire on any shape of antenna. Procedure with Fig 5.13.1 is given below,

> If you select faces or variable of shape to point out the menu Edit>
Object> desire item (like select patch and feedline)

» Then click on select button

» Then select the menu Modeler > Boolean > subtract

» When you need to unite desire item same procedure repeat just when you
point out Modeler > Boolean > Unite

Now you have the desire shape to select Boundary which is the next design
procedure to create a microstrip patch antenna on Ansoft HFSS.

&N Ansoft HFSS - Project7 - HFSSDesignl - 3D Modeler - SOLVED - [Project? - HFSSDesignl -
Project Draw Modeler HFSS Nind Helf

Tools — Window
fezem | or B i I~ 2 5

===============

pofEaanaanaz](i;

Froject

Fig 5.13.1: Selection of Boolean function in design tree of HFSS.
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5.10.1Boundary Condition:

The following boundary conditions must be applied while creating a
project of patch antennas:

e Perfect E boundary on the top of the dielectric (simulates a metal
layer)

e Perfect E boundary on the bottom of the dielectric (simulates a
metal layer)

e Perfect E boundary on the trace (simulates a metal layer)

Radiation boundary on the long sides of the dielectric (simulates the
material extending to inanity in that direction) .To applies these boundary
conditions,

» Right click in the 3D modeler window and click Select>assign
boundaries.

» For selecting boundaries you have to select the faces first which
faces you want in the boundaries ,for this you have to open the Edit>
select>faces.

» Now, select perfect E1 shape for substrate, perfect E2 shape for
ground and after creating Radiation Box it will also have to assign in
radl boundary and click ok for all this procedure. You can change
the name of the E1, E2 to your desire shape name that you created
on your HFSS Project.

» To check that the boundaries are created correctly, expand the
\Boundaries" item in the Project Tree, and you should see PerfE1l,
PerfE2 and Rad1 or similar.

> Highlight PerfE1, PerfE2 and you should see hash marks indicating

which regions of the model apply to this boundary. Highlight Radl
to see the same information for the radiation boundary.
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Following Fig5.13.2

Is given below

Project Manager

E

E

£
E

= Project7
=g HFSSDesign1 (DrivenTerminal)

-3 Excitations

..... BB Mesh Operations
- ﬁ Anahysis

- [f@] Optimetrics
-[F] Results

[ Port Field Display
..... My Field Overays

E

]';' Radiation

-7 Definitions

Proiect |

5.10.2 Excitations

Fig: 5.13.2

Boundaries

We will create a wave port excitation at each end of the circuit. To do so,
we perform the following steps:

» Select the face of the nearest end of the circuit
» First you have to change the solution type > driven Terminal
» Right click in the 3D modeler window and select Assign

Excitation =>
Click Next

VYV VY

Wave Port

Then select the Terminal Naming > Use Port Object Name.

» Press OK and then change the grid line to XY axis.

The same steps should be performed to create a wave port at the other end of the

circuit. Following Fig 5.14

IS given below
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G- ﬁ Analysis
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- Port Field Display

..... T Fisld Overlays g Excitations

Fig: 5.14

5.11 Analysis
Perform the following steps to set up the analysis options:

> Right click on Analysis in the Project Tree, and select >Add
Solution Setup.

» Under the General tab:

» Set the solution frequency 2.4 GHz

» Set the maximum number of passes to 20

» Set maximum Delta S to 0.02

Perform the following steps to set up the frequency sweep:
Under the Analysis item in the Project Tree, right-click on Setupl

> Select Add Frequency Sweep.
» Set start frequency to 3 GHz
» Set stop frequency to 10 GHz
> Set step size to 0.01 GHz

» Click OK
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Following Fig 5.15.1 and Fig 5.15.2 will show the procedure.

Solution Setup

General | Options I Advanced I BExpression Cache I Derivatives I Defaults I

Setup Mame: ISetup‘I
|+ Enzabled I~ Solve Ports Only
| Solution Frequency': |2.4 IGHz vI

Adaptive Solutions

| Mazdmum Mumber of Passes: Izu
% Maximum Delta S Iﬂ-tI2

' Use Matrix Convergence Set Magnitude and Phaze. . I

Use Defaults I d

oK Cancel
Fig 5.15.1
Edit Sweep | = |
Sweep Mame: ISweep ¥ Enabled
Sweep Type: lh
AR = I Countl Frequency

Type: Im
Start |3— m Display > |
Stop I'ID— m
Step Size W m {

¥ Save Fields

[~ Generate Fields [l Frequencies)

Time Domain Calculation. . |

r Interpalating Sweep Options DT Extrapolation Option:

I & S olutions: 250 ™ Estrapolate to DC
finimum Saolved Frequency II] 1 GHz = .

Errar Tolerance: IU.5 4

Advanced Options.. |

oK | Cancel Set Defaults Use Defaults

Fig 5.15.2
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5.12 Final validate Checks and Running the Simulation

The procedure is given below

» Select HFSS > Validation Check to ensure the project is prepared for
simulation (Click-close).

» Save the project by clicking on the save icon at the top of the screen.
» Right-click setupl under Analysis in the project tree, select Analyze to
begin the simulation. At this point the progress window should show

the progress of the simulation, beginning with the mesh generation.

Showing by Fig 5.16.1

Validation Check: Project? - HFSSDesignl Y

) o Design Settings
o HFS5Designt & 0 Model
o Boundaries and Excitations

Y alidation Check complsted. ¥ Mesh Operations
o Analyziz Setup
o/ Optimetrics

¥ Radiation

| Cloze

5.12.1 Simulation Results
To view the results of the simulation, perform the following steps:

» Right click on the results item in the Project Tree.

» Click Create Modal Solution Data Report =>Rectangular Plot.

» Under the trace tab, select the S-Parameter that you wish to view and click
New Report.

» Add additional S-Parameters by highlighting them and clicking Add trace

» Click close.
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Following Fig 5.16.2 will show this,

Q Report: Project? - HF5SDesignl - XY Plot 1 - dB(St(wave_port_T1,wave_port T1)) =
e Trace ] Families ] Families Displa}rl
Solution: Setupl : Sw
jsetup1 s Sweep =l Primary Swesp: |Freg | fan =
Domain: Sw
| weep j s [v Default |F|'eq J
: W W Range
e |C|B(StI:AaVEJDDFt_TI,ABVEJ:IDI't_Tl:I) Function. ..
Cateqgory: Quantity:| filter-text Function:
Variables - <none: -
Cutput Variables ang_deg
ang_rad
arg
= cang_deg =
Terminal YSWR cang_rad
Terminal Port Zo
Group Delay R dB10normalize ||
Active 5 Parameter dB20normalize
R Active Y Parameter dBc
W Real time Active Z Parameter  + | 4 | m ko im K
Output Variables. .. ‘ Options... | Mew Report | Apply Trace ‘ Add Trace ‘ Close
Fig: 5.16.2

Creating the radiation pattern, procedure is given below:

» First select Menu HFSS>Far fields>Infinite spherel

» Then editing the phi> start with 0, Stop with 360 others values will
remain same.

» Then press Ok

» Adgain click the Result > Create Far Fields> Radiation Pattern

» Then it will show the result.

Other results VSWR, Gain graph, Total gain in 3D or other varieties, similar
procedure you have to follow.
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Following Fig 5.16.3and Fig 5.16.4 will explain the procedure properly,

Far Field Radiation Sphere Setup | 2= |
Infinite Sphere I Coordinate System I Radiation Surface I |
Mame Ilnﬁni‘te Sphere1
— Phi
Start [o |deg I
Stop IB-'ED Ideg ;I
Step Size IB Ideg ;I
— Theta
Start [o |deg I
Stop [1e0 |deg I
Step Size IB Ideg ;I
Sawve As Defaults I View Sweep Points. .. I
oK | Cancel | Help |

Fig 5.16.3: creation of infinite sphere

& Report: Project? - HFSSDesign] - Radiation Pattern 1 - dB(rETotal) [ = |
e Trace | Families I Families Displayl
Solution: Setup1 : LastAdapti
I Flpl i Lastadaptive ;I Primary Sweep: IThEiB ;”-‘\" _|
Geometry: |Infinite Spherel i
? | ph —I ang: v DefﬁuItITheta _I
R
Mag: I':IB(”:—I—‘]E“:I FL?::E:I;on... |
Category: Quantity:| filter-text Function:
ang_rad R
rEFPhi asin
rETheta asinh
rEx atan =
rEY atanh
rEzZ cos
rELHCP cosh
rERHCF
i Antenna Params rEL3¥% dB 10normalize
BodaEiRepat Design rEL3Y dB20normalize
[ Real time  Update "l dBc -
Qutput Variables. .. | Dpﬁons...l Mew F‘.eportl Apply Trace | AddTracel Close |

Fig 5.16.4: Creation of radiation pattern procedure.
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5.13 Advantages of HFSS:
Ansoft HFSS is given below:

e Advanced Layout Capabilities

» Improved Extraction

» Enhanced Frequency Sweep techniques

» New Broadband SPICE model generation
« Ansoft Designer

» Advanced Simulation Technology

> IBIS AMI

> Full Channel for Compliance

» Productivity Enhancements

» HPC for Speed
» Distributed Solve for Design Space Characterizations for

designing Antennas.
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Chapter 6

Patch Antenna Analysis

In our Thesis Paper we use Rogers RT/druid 5880™ material as the
Substrate in Ansoft HFSS (13) to have the desire gain at -10 db. We create a
new Microstrip patch Antenna D over D shape to have our desire gain for the
ultra-wide band application. Here we will discuss about the result of the shape
of the patch.

6.1: Rogers RT/duroid 5880™ High Frequency Circuit Material

RT/duroid® 5880 high frequency laminates are PTFE composites
reinforced with glass microfibers. These microfibers are randomly oriented to
maximize the benefits of fiber reinforcement in the direction most valuable to
circuit producers and in RT/duroid 5880 high frequency laminates are PTFE
composites reinforced with glass microfibers. The final circuit applications.

The dielectric constant of these high frequency laminates is the lowest of
all products, and low dielectric loss make them well suited for high frequency/
broad band applications where dispersion and losses need to be minimized.
Because of its extremely low water absorption characteristics, RT/duroid 5880
laminates are ideal for applications in high moisture environments.

RT/duroid 5880 laminates are easily cut, sheared and machined to shape,
and resistant to all solvents and reagents normally used in etching printed
circuits or plating edges and holes. RT/duroid 5880 laminates have the lowest
electrical loss of any reinforced PTFE material, low moisture absorption, are
isotropic, and have uniform electrical properties over frequency.

When ordering RT/duroid5880 laminates, it is important to specify
dielectric thickness, tolerance, rolled, electrodeposited or reverse treated copper
foil, and weight of copper foil required
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Fig 6.1 Rogers RT/duroid 5880™
Table 6.1 Data Sheet of Rogers RT/duroid 5880™

PROPERTY TYPICAL VAL UE DIRECTION UNITS CONDITION TEST METHOD
Dislectric Constant, ¢, 2.20 z C24/2350 1 MHz IPC-TM-650 2553
220 £ 0.02 spec. z — C24/2350 10 GHz IPC-TM-650 2555
Dissipation Faclor, tan B 0.0004 z — C24/2350 1 MHz IFC-TM-850 2553
0.0009 z C24/2350 10 GHz IPC-TM-650 2555
Violume Resiativity 2510 z Mohm cm CH335m0 ASTM D257
Surface Reslativity IX 00 Zz Mohm CONI500 ASTM D257
Tenslle Modulus Test at Test at 100 C MPa (kpsi) A ASTM DE38
23¢C X
1070 {158) 450 (B5) ¥
BEO (125) 380 (55)
ultimale stress | 20 (4.2) 20 (2.8) X MP'a (kpsi)
2T (e 18 (2.6) ¥
ultimate strain 6.0 72 X %
4.8 58 ¥
Compresshme Modulus 710 (103) 500 (73) X MPa (kpsi) A ASTM DBSS
10 (103) 500 (73) ¥
440 (138) &70 (97) z
ultimale siress | 27(3.9) 2232 X MP'a (kpsi)
21 (3 ¥
B2 (7.5) 43 (6.3) z
uliimate sirain 85 84 X %
77 78 ¥
125 176 z
Deformation Under Load Test at 150 C ASTM D&21
1.0 z % 24 b4 MPa (2kpsi)
Waler Absorpiion mg (%) D24i23 ASTM D570
Thickness = 0.8 mm (0.031) 09 {0U02)
Thickness = 1.6 mm (0.062) 13 (0.1 5)
Specific Gravity 22 ASTM D792
Haat Distortion Temparaturs =260 (=500) XY C{F) 1.82 MPa (264 psi) ASTM DE43
Specific Heat 0.96 (0.23) Jigh (BTUMRY F) Calculated
Thermal Conductivity 020 z Wi ASTM C518
Thermal Expansion ® Y z e mmim ASTM D33E6
{1 Okfmin)
.1 |47 -18.7 -100 G
08 18 £8 15
{Values given are total change from a
05 08 -5 28 base temperature of 35 C)
11 15 87 75
23 3z 283 150
38 55 605 250
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6.1.1: Features and benefits Of Rogers RT/duroid 5880™

* Lowest electrical loss for reinforced PTFE material.
* Low moisture absorption.

* Isotropic

* Uniform electrical properties over frequency.

* Excellent chemical resistance.

6.1.2: Uses
Rogers Rogers RT/duroid 5880™high frequency laminates are used in:

« Commercial airline broadband antennas.
« Microstrip and strip line circuits.

« Millimeter wave applications.

- Military radar systems.

« Missile guidance systems.

« Point-to-point digital radio antennas.
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6.2: D over D shape Microstrip patch Antenna:

The objective of this chapter is to know about this new shape for how you
can create, simulate and analyze a microstrip Patch antenna resonating at a dual
ultra-wide band frequency ranging 4.78-8.48 GHZ is given below:
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Fig: 6.2: Design Window.
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Fig.6.2.1: Microstrip Patch Antenna (perfect D1).
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Fig.6.2.2: Microstrip Patch Antenna (perfect D2)
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HFSS Design Model:

In HFSS design Model will show the necessary Properties which are
essential to design the D over D shape of Microstrip patch antenna. Here the
command window of HFSS Design Model:

Design List: Project? - HFS5Designl
Mode! | Boundaries I BExcitations I Mesh Cperations I Analysis Setup I
Name | Color | Model | Display Wirsframe | Visible | Mateial | Twpe |
substrate || ¥ | [ Rogers R... | Solid
patch ] ¥ | [ Sheet
feed_line ] ¥ | [ Sheet
ground ] ¥ | [ Sheet
Cylinderl || ¥ | [ vacuum Solid
Cylinder2 || ¥ | [ pec Solid
wave_port I ¥ | [ Sheet
radiation_box /= ¥ | [ air Solid
]
Delete Froperties | I Select Done
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Table 6.2: Antenna Design Parameters

Name Material | Length( | Width(W Height Axis Position
L)mm ymm (h)mm
Substrate Rogers 50 49,72 1.6 xX,Y,Z -25,-20,0
RT/duroid
5880 ™
Patchl Sheet 38.04 29.44 Z -23,-16.25,1.6
Ground Sheet 50 42.5 Z -23,-17,0
Feedline Sheet 20 1.8 Z -0.9,9.72,1.6
Radiation Air 50 49.72 60 XY, Z -25,-20,-30
Box
Radius | Height AXis Position
Wave Port Sheet 1.7 Y 0,34.72,1.6
Cylinderl Vacuum 1.7 5 Y 0,29.72,1.6
Cylinder2 Pec 0.7 5 Y 0,29.72,1.6
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HFSS Attribute and Command Window for Substrate:

s

-

| Properties: Praoject? - HFS5Designl - Modeler . | 23 |
Attribute
|
Name Value I Urit I Evaluated Value Description I Read-only | |
MName substrate I_
| Material "Rogers RT/durcid 5880 fm)" "Rogers RT/du... ~
Solve Inside F I_
Oriertation Global ~
| -
Model v -
Display Wirefra... [ ~
Color Edit I_
Transparent 0 ~
I™ Show Hidden J
0K Cancel
Properties: Project? - HFS5Designl - Modeler ® | P |
MName Value I Unit | Evaluated Value Description I |
Command CreateBox
Coordinate Sys... Global
Position -25 -20.0 mm -28mm , -20mm ...
XSize 50 mm 50mm
YSize 4372 mm 49.72mm
ZSize 16 mm 1.6mm
I™ Show Hidden "
0K Cancel

51| Page



HFSS Command window For Patch:

¥

Properties: Project? - HF55Designl - Modeler . | 29 |
Command
MName Value | Unit I Evaluated Value Description | |
Command Create Rectangle
Coordinate Sys...| Global
Pasition -23 -16.25 1.6 mm -23mm , -16.25...
Puds Z [
XSize 38.04 mm 38.04mm
Y5ize 2944 mm 29.44mm
I~ Show Hidden "
E
oK Cancel
\, — A
HFSS Command Window for Feedline:
- -_ - | |'\
PropertiessFinal Project - HFS5Designl - Modeler &=
Command
MName Value I Linit I Evaluated Value Description | |
Command CreateRectangle
Coordinate Sys... Global
Position 0557216 mm -0.9mm , 5.72m...
Pocis Z
KSize 1.8 mm 1.8mm
YSize 20 mm 20mm
[ Show Hidden g
oK Cancel

52| Page



HFSS Attribute and Command Window for Cylinder 1:

Properties: Project? - HFSSDesignl - Modeler I ‘ Y u
Attribute
MName Value I Unit I Evaluated Value Description I Read-only I |
Name Cylinder ]
Material "vacuum” "vacuum” I_
Solve Inside F I_
Orienitation Global ]
Model |7 |_
Display Wirefra... I_ I_
Color Edi [ r I
Transparent 0 | ] I
[~ Show Hidden
oK I Cancel
Properties: Project? - HFSSDesignl - Modeler . = |
Command
Mame Walue I Unit I Evaluated Valuel Description | |
Command CreateCylinder
Coordinate Sys... Glabal
Center Position |0 2972 1.6 mm Omm , 29.72mm...
s Y
Radius 1.7 mm 1.7mm
Height 5 mm Bmm
Number of Seg... D 0 "
™ Show Hidden
QK Cancel
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HFSS Attribute and Command Window for Cylinder 2:

Properties: Project? - HFSSDesignl - Modeler | & |
Attribute
MName | Walue | Unit | Evaluated Value Description I Read-only | |
Mame Cylinder2 [l
Material "pec” "pec” I_
Solve Inside I_ |_
Orientation Global [l
Mode! Ir2 -
Display Wirsfra... I_ |_
Color Edit | ] \
Transparent 0 | I_
[ Show Hidden
OK Cancel
— = ~
Properties: Project? - HFS5Designl - Modeler l g
Command
Name i Value | Lnit I Evaluated ‘u"aluel Description | |
Command CreateCylinder
Coordinate Sys... Global
Center Posttion |0 .29.72 1.6 mm Omm , 29.72mm...
Fods Y
Radius 07 mm 0.7mm
Height kil mm Bmm
Number of Seg... 0 0 "
|
I Show Hidden
QK I Cancel

54| Page



HFSS Command Window for Waveport:

Properties: Project? - HFSSDesignl - Modeler - % |
Command
Name Value | Unit | Evaluated Value Description | |
Command CreateCircle
Coordinate Sys...|Global
Center Posttion |0.34.72 16 mm Omm , 34.72mm...
fods Y i
Radius 17 mm 1.7mm
Number of Seq... 0 1]
[~ Show Hidden "
oK | Concel
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Fig 6.2.3: Ground View
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HFSS Command Window for Ground:

v | |
| Properties: Project7 - HFSSDesignl - Modeler =
I
Command
Mame Value | Lnit | Evaluated Value Description | |
Command CreateRectangle
Coordinate Sys... Global
Position 23170 mm -23mm , -17mm ...
Auis z
XSize 50 mm 50mm
YSize 425 mm 42 5mm
I™ Show Hidden |
oK Cancel
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Fig 6.2.4: Radiation Box (RAD1)
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HFSS Attribute and Command Window for Radiation Box:

Properties: Project? - HF55Designl - Modeler . | %=
Attribute
MName Value I Unit I Evaluated \c’aluel Description I Read-onhy I |
Name radiation_box I_
Material “air" “air” (]
Solve Inside v [l
Orientation Global I_
Model 2 (]
Diisplay Wirefra... I_ I_
Caolor Edit | —
Transparent 0.92 | I_
[~ Show Hidden o
OK Cancel
Properties: Project? - HF55Designl - Modeler ™ | =
Command
MName I Value | Uit I Evaluated Value I Deescription I |
Command CreateBox
Coordinate Sys... Global
Position -25 ,-20 -30 mm -25mm , -20mm ...
XSize 50 mm 50mm
YSize 4572 mm 45.72mm
ZSize &0 mm &0mm
I~ Show Hidden o
QK Cancel

Using this require value we can get the perfect D over D shape Microstrip Patch
Antenna for ultra-wide band application.
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6.3: Simulated Results of Microstrip Patch Antenna:

6.3.1: Return Loss

During this simulation procedure you will get the microstrip patch antenna with
dual band frequency for ultra-wide Band application. Here the Return loss graph
on Ansoft HFSS shown in Fig 6.3
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Fig 6.3.1: Return Loss of Microstrip Patch Antenna.
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Here having the Fig 6.3.2 of VSWR

XY Plot 12 HFSSDesign 2.
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Fig 6.3.2: Simulation Result of VSWR

Using the given equation in chapter-4 of Return Loss equation is -20log
S1;1 of dual-band frequency for ultra-wide band application for this desire
antenna are -25.83and 22.01 and we also can have the % of Bandwidth of this
dual-band frequency of ultra-wide band application that is f,-f;/fo*100 where f,
Is maximum frequency range,f; is minimum frequency range,f, is center
frequency of both this maximum and minimum frequency range below -10
return loss curve is accepted, where f,=f,+f,/2 .By using this equation we have
the maximum Bandwidth (BW) which is 55.81% where f,-4.78,f,=8.48 and
f0=6.63.
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The comparison of changing substrate thickness, Ground position and
Feedline position we get this result from this desire antenna, the tables are given
below to show how the changing of substrate thickness, feed position and
ground position can effect to have this result:

Table 6.3: Data Sheet of Different Substrate Thickness of Rogers RT/duroid
5880 ™ for % of BW:

Material Name

Substrate Thickness
(mm)

% of BW:(fz'fl)/fo*loo

Rogers
RT/duroid
5880(tm)

0.5

8.2

7.02

9.1

25.8%

Rogers
RT/duroid
5880(tm)

0.75

7.8

6.75

8.8

26.3%

Rogers
RT/duroid
5880(tm)

7.4

6.36

8.4

27.6%

Rogers
RT/duroid
5880(tm)

1.26

7.1

6.1

8.1

28.2%

Rogers
RT/duroid
5880( tm)

1.6

6.62

4.79

8.44

55.14%

Rogers
RT/duroid
5880( tm)

6.61

4.77

8.43

55.37%

Rogers
RT/duroid
5880(tm)

2.26

5.78

4.77

6.79

34.87%
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Table 6.4: Data sheet of Different ground position for % of BW

Material Length(L) | Width(W) Ground fo f1 f, | % Of
position BW=(f,-
1)/f4*100%
Sheet 25 25 -25,-20,0 6.61 |7.1 8.45 | 17.74%
Sheet 45 22.5 -25,-20,0 7.7 |7.18 |8.28 |15.33%
Sheet 45 42.5 -25,-20,0 6.32 |55 7.14 | 25.94%
Sheet 50 49 -25,20,0 7.055|561 |85 |40.96%
Sheet 50 45 -23,-18,0 6.645|4.79 |85 |55.80%
Sheet 50 40 -22,-15,0 6.71 |4.76 |8.60 |50%
Sheet 45 40 -21,15,0 7.73 470 |8.67 |51.36%
Sheet 50 42.5 -23,-17,0 6.63 |4.78 |8.48 |55.81%
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Table 6.5: Data Sheet of Different Feed Position for % BW

Material Name Feed Position | f, f; fy % of BW=(f2-f1/f;)*100
Pec
-1.55,11.5,16 | 6.635| 5.35 7.38 31.8%
Pec -1.5,10.5,16 | 6.635| 4.8 8.47 55.31%
Pec -1.25,115,1.6 6.68 | 4.84 8.52 55.09%
Pec -1.25,10,1.6 6.79 | 4.92 8.66 55.08%
Pec -1,99,1.6 6.64 | 4.79 8.49 55.72%
Pec -0.9,9.72,1.6 6.63| 4.78 8.48 55.81%
Pec -0.7,10,1.6 6.62 | 4.79 8.45 55.14%
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Gain:
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Fig.6.3.3: Simulation result of gain.
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6.3.2: Radiation Pattern:

Radiation Pattern 1

-90 90

-120 120

HFSSDesign1 &

T
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Fig.6.4: Radiation Pattern.

6.3.3: 3D radiation Pattern:
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Fig.6.5: 3D polar plot for radiation Pattern on HFSS.
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6.3.4: 3D Gain Total:

dB(GainTotal)

4, 1050 +060
3.0294e+000
1, 9538 +000
8. 7825¢-001
-1,9732¢e-001
-1, 2729¢+000
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-3, 4240e+200
-1, 4996e+200
-5, 5752¢+000
-6, 6508e+000
-7, 7263e+000
-8, 8019e+000
-9, 8775¢+000
-1,0953¢+001

[x]

Fig 6.6: 3D Polar plot for Gain on HFSS.

This is the final output results of simulation having the clear concept of

every material that is used to create this Microstrip Patch Antenna for ultra —
wide band application for this D over D shape Antenna. Here the maximum %
of Bandwidth is 55.81% ,return losses are 25.83-22.01 for its dual band nature,
gain is around 2-5 dB and VSWR (voltage standing wave ratio) is < 2 in its
frequency range, so we can considered it as a good design of antenna having
dual band .
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Chapter 7

Conclusion

In This Thesis Paper we want to create a new shape to have better
efficiency, better bandwidth, Return loss, gain to create an Antenna that will
have every possible facility to give an excellent output using Ansoft HFSS. We
use several materials to have a desire output that we have finally Rogers
RT/duroid5880™ is given us a good result of dual band frequency at 4.78-8.48
having the Return loss at 25.83-22.01 with maximum % of BW is 55.81 % and
gain is about 2-5 dB. During this Antenna design we have faced a lot of
problems to have this output. We have to oversee several things like we have to
change the thickness of substrate, feed line position, Ground position and
parameters of Antenna to have this desire Result. Major parameters such as
Return loss,VSWR, Radiation Pattern, Gain, and Bandwidth is good enough to
create this D over D shape Antenna having Performance analysis of Microstrip
Patch Antenna for ultra-wide band Application which can be used in several
wireless application like Router,WI-FI,Modem,WLAN and many other.
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